Lesson 3:  Character Formatting
Step by Step 1: Change Fonts and Font Sizes
· [image: ]GET READY. Before you begin these steps, be sure to LAUNCH Microsoft Word.
1. Locate and open the file 
named Class Descriptions.
2. Within the document, 
select the first line.
3. In the Font group of the 
Home tab, click the Font 
drop-down arrow to display 
the Font menu. The menu 
appears, as shown at right.
The first line is formatted with the Theme Font, Calibri.
4. [image: ]Scroll down the list and 
position the mouse pointer 
on Century Gothic. Notice 
that as you point to each 
font in the list, the selected 
text changes with a live 
preview of what it would 
look like in that font.
5. Click Century Gothic.
6. With the text still selected, click the drop-down arrow on the Font Size menu. The menu appears, as shown above.
7. Click 18.
8. Select Group Exercise Class Descriptions.
9. [bookmark: _GoBack]Click the drop-down arrow to open the Font menu, and then select Gadugi.  You can save time by typing the font name in the Font box.
10. With the text still selected, open the Font Size menu and select 16.
11. Select the remainder of text in the document.
12. [image: ]Point to the selected text to 
display the Mini toolbar. If you 
accidently deselect the text, select 
it again to display the Mini toolbar.
13. Click the drop-down arrow on the 
Font menu on the Mini toolbar and 
choose Constantia (right). Word 
displays one font at a time in the 
Font text box. When you continue 
to change the font, you see a 
listing of recently used fonts.
14. With text still selected, click the Font Size menu on the Mini toolbar and choose 12.
15. Click in a blank area of the document to deselect.
16. Select Preston Creek Family YMCA.  In the Font group, click the Increase Font Size button once to increase th size of the text.
17. Click the Increae Font Size button three more times until the point size is 26.  Notice that each time you click the button, the number in the Font Size text box changes.
18. Click in a blank area of the document to deselect.  
19. Save the document as Classes in the lesson folder in your Chapter 3 folder located on the desktop.
· Pause.  Leave the document open to use in the next exercise.
Step by Step 2: Apply Character Attributes
· USE the document that is open from the previous exercise.
1. Select the title of the document, Preston Creek Family YMCA.
2. In the Font command group, click the Bold  [image: ] button. Notice that the Bold button in the Font group is now selected.
3. Select the subtitle, Group Exercise Class Descriptions, and click the Italic [image: ] button. The Italics button appears highlighted.
4. [image: ]Select Active Older Adults and click the Bold button on the Mini toolbar.
5. With the text still selected, click the Underline [image: ] button on the Mini toolbar.
6. With the text still selected, click the drop-down arrow beside the Underline button.  A menu of underlining choices appears, as shown at right.
7. Hover over each option to see how the select text will appear, and then click Thick Underline, the third line down in the menu.  Before you click, a Screen Tip displays Thick Underline.
8. Select the title, Preston Creek Family YMCA.  In the Font group, click the dialog box launcher.  The Font dialog box appears, as shown above.
9. In the Effects section, click the All Caps check box to insert a check mark. Review the Preview area and notice how the text is now in all caps.
10. Click the drop-down arrow on the Font Color menu. A menu of colors appears.
11. A ScreenTip appears when you place your insertion point over the colors; click Aqua, Accent 5, Darker 50 from the Theme Colors section at the top.
12. Click OK.
13. [image: ]With the text still selected, click the Text Effects drop-down arrow in the Font group.
14. Hover over each of the options, and then select Fill – White, Outline - Accent 1 Shadow, as shown below. Applying the Text Effects to the selected text changes it back to the original capitalization.
15. With the text still selected, right-click to access the shortcut menu, and then select 
Font.  Click the Text Effects button to open the Format Text Effects dialog box.  Notice that you have two options to select:  Text Fill & Outline   [image: ]    and Text Effects    [image: ]    .  You can access the command to display additional options by clicking on the icon or expand  [image: ]    button.
16. [image: ]Click the Expand button by 
the Text Fill command 
(right).
17. Select the Gradient fill 
radio button, and then 
click the drop-down arrow 
by the Preset gradients 
and select Medium 
Gradient – Accent 2.
18. Click the drop-down arrow to change the Direction and select Linear Diagonal – Top Right to Bottom Left.  The Angle changed from 2700 to 1350.  The position of the gradient can be changed by using the Gradient stops slider.  Position the slider to 26% by dragging the slider to the left or decreasing the percentage by clicking the down arrow key by the Position command.
19. Click OK to close the Format Text Effects dialog box, and then click OK to close the Format Text Effects dialog box.  Review the changes you made to the heading.
20. Click OK, and then deselect the text.
21. Save the document in the lesson folder.
· Pause.  Leave the document open to use in the next exercise.
Step by Step 3: Change Case
· USE the document that is open from the previous exercise.
1. Select the title, Preston Creek Family YMCA. In the Font group, click the Change Case        button. A menu of case options appears, as shown below.
2. Click UPPERCASE. All letters are capitalized.
3. [image: ]With the text still selected, click the Change Case button again and select lowercase.
4. With the text still selected, click the Change Case button again, and then click Capitalize Each Word.
5. Select Ymca.  Click the Change Case button again and choose UPPERCASE.
6. Click in a blank area of the document to deselect the text.
7. Save the document in the lesson folder.
· PAUSE.  LEAVE the document open to use in the next exercise.
Step by Step 4: Highlight Text
· USE the document that is open from the previous exercise.
1. Under the Core Express heading in your document, select the last sentence, “This new class is open to all fitness levels!”
2. In the Font group, click the Text Highlight Color  [image: ]    button. The text automatically is highlighted in the default color yellow.
3. Select the text you highlighted in step 1.
4. Click the drop-down arrow beside the Text Highlight Color button. A menu of colors appears, as shown below.
5. [image: ]Click dark blue (the second color in the second row of the menu). Notice the highlight color in the text is too dark and you cannot see the text. To solve this problem, you change the Font Color to a lighter color.
6. Select the text again.  Click the Text Highlight Color button again.  To remove the highlight color, Select No Color.
7. Selcect the text again and apply the yellow highlight color.
8. Save the document with the same filename in the lesson folder.
· PAUSE.  LEAVE the document open to use in the next exercise.
Step by Step 5: Use the Format Painter
· USE the document that is open from the previous exercise.
1. Select the Active Older Adults heading.
2. On the Home tab, in the Clipboard group, click the Format Painter [image: ]      button once; Format Painter copies the formatting from your selected text, and the pointer changes to a paintbrush icon when you point to text.
3. Use the paintbrush pointer to select the next heading, Boot Camp. The copied format is applied, and the Format Painter is turned off.
4. With Boot Camp still selected, double-click the Format Painter button. Notice the status bar message “Select content to apply the copied formatting, or press Esc to cancel.” Notice also that the mouse pointer becomes a paintbrush icon when you place it over text. You will now be able to apply the same formatting to several items in the document.
5. Select the next heading, Cardio Combo. The copied format is applied.
6. Select the next heading, Cardio Kickboxing.  The copied format is applied again.
7. Select the remaining headings using the method you learned to select multiple text by pressing CTRL, and then click the text to apply the copied format.
8. When you are finished with the last heading, click the Format Painter button to turn it off or press the ESC key.
9. Save the document in the lesson folder.
· PAUSE.  LEAVE the document open to use in the next exercise.
Step by Step 6: Apply a Style
· USE the document that is open from the previous exercise.
1. Select the Active Older Adults heading. In the Styles command group on the Home tab, click Heading 1. The style is applied to the heading.
2. Use multi-selection to select all the headings, and then click Heading 1. The Heading 1 style is applied to all the remaining headings.
3. [image: ]In the second 
sentence of the 
Active Older Adults 
description, select 
low-impact. In the
Styles group, click 
the dialog box 
launcher. The 
Styles window 
appears, as shown 
at right.
4. Point to Subtle Emphasis in the Styles list. Notice a ScreenTip appears with the defaults for this style. Click Subtle Emphasis. The style is applied to the selected text.
5. In the Boot Camp description, select challenging and click Subtle Emphasis in the Styles window.
6. In the Core Express description, select strengthen and click Subtle Emphasis in the Styles window.
7. In the Indoor Cycling description, select high-energy and click Subtle Emphasis in the Styles window.
8. In the Yoga description, select breathing and relaxation and click Subtle Emphasis in the Styles window. Deselect the text. Click the X to close the Styles window.
9. Open the Navigation Pane and practice browsing through the document using the Headings tab.
10. SAVE the document in the lesson folder on your flash drive.
· PAUSE. LEAVE the document open to use in the next exercise.


Step by Step 7: Modify Styles
· USE the document that is open from the previous exercise.
1. [image: ]In the Style group, click the dialog box launcher to display the Styles window.
2. Select Subtle Emphasis, 
and then right-click to 
display the Subtle 
Emphasis menu or click 
the drop-down arrow, 
as shown at right.
3. Click Modify.  The Modify Style dialog box appears, as shown below.
4. Click the Bold button.

[image: ]













5. Click the Font Color drop-down arrow, and then select Dark Red in the Standard Colors section.  Notice the preview in the dialog box changes.
6. Click the Add to Styles gallery check box to clear it.  The modifications you just made apply to this document and not of the Style list.
7. Click the Format button, and then select Font.  The font dialog box opens to give you more options.  
8. In the Effects section, add a check mark to small caps.
9. Click OK to close the Font dialog box.
10. Click OK, and then close the Modify Styles dialog box.  Notice how the text automatically changes to the modification you just completed.
11. Close the Styles window by clicking the X.
12. In the Styles group, right-click Heading 1, from the gallery to display the Heading 1 menu, and then click Modify.
13. In the Modify Style dialog box, click the Font Color drop-down arrow and choose Red, Accent 2, Darker 50%.
14. Click the Font Size drop-down arrow and select 18.
15. Click the Add to Styles gallery check box to clear the check mark. The modifications made apply to this document and not on the Style list.
16. Click OK.  All the headings with the Heading 1 style update automatically to the new color and size.
17. Save the document in the lesson folder on your desktop.
· PAUSE.  LEAVE the document open to use in the next exercise.
Step by Step 8: Insert WordArt

· [image: ]USE the document that is open from the previous exercise.
1. Select Preston Creek Family YMCA.
2. Click the Insert tab and, in 
the Text group, click the 
WordArt button to display 
the menu as shown at
right.


3. In the WordArt gallery, select Fill – Red, Accent 2, Outline – Accent 2 (first row, third option). The text is now formatted as WordArt and the Drawing Tools Format tab opens.
4. A box appears around the WordArt; select the heading and change the font size to 28 pt on the Home tab. Notice the word Group moved up one line.
5. Place your insertion point along the box outline until it changes to the move command—four arrows. Press the left mouse button to select the box, and drag the box to the horizontal center until the word Group moves to the second line. As you resize or move a heading, the text that surrounds the box automatically moves.
6. Select the heading text again. In the WordArt Styles group on the Drawing Tools tab, select the drop-down arrow by Text Outline [image: ]  and select No Outline. This action removes the outline in the text.
7. [image: ]Click the Text Fill       drop-down arrow and select Red, 
Accent 2.
8. Select the Text Effects, 
and then click Transform 
(right).
9. Hover over the options 
under the Warp section—
see how your text changes 
with live preview. Select 
Double Wave 1.
10.  SAVE the document in the 
lesson folder on your desktop then CLOSE the file.
· PAUSE. LEAVE the document open to use in the next exercise.

Step by Step 9: Import a PDF File and Apply Formatting
1. OPEN the Tech Terrace 3.pdf file from the data files for this lesson. A prompt appears stating, “Word will now convert your PDF to an editable document.” (see below).
2. [image: ]Click OK. By opening the PDF document, you have imported the document into Word. The Ribbon, is now active and you can begin applying formatting to the document
3. Select the whole document by pressing CTRL+A, and then change the Font to Times New Roman and Size to 12 pt. You can also select text from the Editing group on the Home tab.
4. In the first paragraph, select Tech Terrace Real Estate, and then format the text with Bold, Italics, text color to Dark Red, and Small Caps.
5. In the first paragraph, select sold, renovated, appraised, leased, and managed and format by italicizing and bolding and changing the color to Blue-Gray, Text 2.
6.  Save As a PDF file in your flash drive and change the filename to Tech Terrace Update.pdf. The new document opens in a new window. Notice the file contains the updated formatting changes.
7. To close the window, point to the upper-left corner, and the document you are editing appears as a thumbnail. Click to return to the Word screen.
8.  CLOSE the file. If a prompt appears to confirm saving the changes to the Tech Terrace 3.pdf file, click Don’t Save.
· PAUSE. LEAVE Word open for the next exercise.
Step by Step 10: Use the Clear Formatting Button
· OPEN the Classes document from the lesson folder.
1. Select Active Older Adults. In the Font group, click Clear Formatting   [image: ]    . The formatting is removed and the text returns to the default font, Calibri.
2. Select Boot Camp. In the Styles group, click the More drop-down arrow, and then click Clear Formatting. The formatting is removed.
3. Press and hold Ctrl and select Cardio Combo; continue to hold the Ctrl key to select the remaining headings and then click the Clear Formatting button in the Styles group.  (By holding the Ctrl key, you can use multiselection to select noncontguous text.)  Deselect all the text and click the X to close the Style window.
4. SAVE the document as Classes 2 in the lesson folder on your desktop.
· CLOSE Word.
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